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I. Even if you hate manuals�

PART I : Even if you hate manuals…

You Must Read This
TribeStar has been designed for easy installation. However, like any other sophis-
ticated networking equipment, care must be taken when installing TribeStar to
ensure proper network operation.

You may have noticed a registration card in your TribeStar package. Please return
your card immediately. We use this information to provide you with proper
technical support, to inform you of any bug fixes or additional features, and to
send you free firmware and SwitchMonitor upgrades.

Compatibility
All Ethernet devices and routers connected to TribeStar must be compatible
with AppleTalk Phase 2.

The Ethernet network to which TribeStar connects must have a network
number range of a single value (e.g., 61-61). If your TribeStar is not connected
to a network that already has a router, TribeStar automatically assigns the correct
Ethernet network number.

In topologies where TribeStar is connected to routers on its Ethernet side,
you must configure the routers so that the Ethernet network number has a
range of a single value.

TribeStar’s management software, SwitchMonitor ™, displays a network map
of devices connected to TribeStar. For this map to display properly, make
sure that non-System-7 Macs have the Responder init in the System Folder.

You must strictly follow the 8-step procedure in the chapter Installing
TribeStar . Otherwise, your network may crash or exhibit random behavior.
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Unpacking TribeStar

Unpacking TribeStar
Thank you for choosing TribeStar, the revolutionary multi-port LocalTalk-to-
Ethernet switching hub. Zoom Telephonics is a leader in value-added equipment
for AppleTalk, offering unique, easy-to-use products to help you optimize the
performance of your networks.

In addition to this user’s guide, the TribeStar package includes:

� A power cord.

� A wall mounting bracket.

� The SwitchMonitor disk, which contains the SwitchMonitor network manage-
ment software.

Note the location and names of the various ports and items on the TribeStar unit
in the following illustration. Knowledge of each of these will be important during
the installation process and when troubleshooting any problems.
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Unpacking TribeStar

Installation Checklist
In addition to the TribeStar package, you should have the following components:

� An Ethernet transceiver (e.g., 10BaseT or 10Base2 type) to attach to the
TribeStar’s AUI port. If you bought your transceiver from Zoom, the SQE
should already be set to “ON.” If you bought your transceiver from a third
party, consult their instructions for the proper setting.

� If you plan to use 10Base2 Ethernet cables (ThinNet): appropriate lengths of
cable, cable T-connectors and terminators (one for each end of the daisy
chain). See the ThinNet section.

� If you plan to use 10BaseT Ethernet cable: a 10BaseT hub and one
10BaseT cable for each Ethernet device. If you connect the TribeStar to only
one Ethernet machine, you do not need a 10BaseT hub, but you must use a
special 10BaseT cable with the send and receive wires reversed in one end.
(See the illustration in the Making Your Own Cables  section in Part III .)

� A wiring kit consisting of an RJ-21 cable and either a punchdown block or 8-
port patch panel. The wiring kit is used to connect the TribeStar to your
LocalTalk network. These wiring kits are available from most resellers or
directly from Zoom.
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Installing TribeStar

Installing TribeStar—8 Steps to Success
This chapter assumes that your network is wired and ready for installing
TribeStar. This is the case if you are installing a network into a prewired site or are
replacing a LocalSwitch® or a multi-port repeater such as a StarController™.

If you do not have a network installed, please see the chapters Planning a New
Network and Wiring Your New Network.

Before plugging in TribeStar to replace an existing repeater hub, please check
your network wiring for loops within the network, or for terminating resistors that
might have been lost or removed. (A wiring loop occurs when a wire goes out
from the hub and loops back into the hub between ports or within one port.) A
terminating resistor whose wires are twisted until they cross has the same effect
on a network as a loop. Loops or lack of termination can cause high numbers of
errors that will bring your network to a crawl. In addition, if you have a
LocalSwitch, check that the ROM version is up to date. Contact Zoom Technical
Support at (617) 753-0700 if you are not sure about this.

Your TribeStar comes from the factory pre-configured to adapt itself to your
network (soft-seeded). If you did not get your TribeStar factory direct, you should
make sure that it is soft-seeded. If it is not configured correctly, your network may
crash because of a conflict in network number or zone name. To install
SwitchMonitor, TribeStar’s management software, follow the directions in the
SwitchMonitor: Managing Your Network  chapter To configure TribeStar
properly, follow the directions in the AppleTalk Configuration  chapter. To config-
ure TribeStar for MacIP, refer to PART V: TribeStar IP.

To install TribeStar, please strictly follow the procedure below.

1. Check that your Ethernet is configured with a network number with the range
of 1. Also, if you have a LocalTalk router, make sure that your EtherTalk is
configured with a single zone name.

2. Shut down all non-router nodes to be connected to TribeStar. If you have
routers, leave your routers on.

3. Connect TribeStar’s AUI to your Ethernet network using the appropriate
transceiver . If you purchased the transceiver from Tribe, the DIP switches
on the transceiver have been set to work with TribeStar. If not, consult their
instructions for the proper setting. Close the latch to secure the transceiver.
(See the illustration in the Ethernet Transceiver section in Part III  .)

4. Connect TribeStar to your LocalTalk network. Unplug the 50-pin RJ-21 cable
from the LocalSwitch or StarController, and plug it into your TribeStar. The
cable must point away from the LEDs. (See the illustration in the Wiring
Your New Network chapter in Part III  for the cable’s orientation on
TribeStar.)

5. As a StarController has 12 ports and a LocalSwitch 16, you need to redis-
tribute these ports among TribeStar’s 8 ports. The next illustration shows
the port designation on a punchdown block for these three hubs. Note that
TribeStar’s ports correspond to the first 8 ports of the StarController, so you
only need to move ports 9 through 12. This also applies if you have a 12-port
StarController patch panel. When connecting a LocalTalk router or
LocalSwitch to a TribeStar, do not use port one.



8 TribeStar User�s Guide

6. Plug the power cord into the back of the TribeStar and then into an electri-
cal outlet. Turn on the power switch located on the back of the TribeStar.

7. Upon start-up, TribeStar undergoes a system self-test. Look for the
correct sequence of LED lighting:

1st � all LEDs are amber

2nd � LEDs are alternately green-red-green-red, etc.

3rd � all LEDs are red

4th � all LEDs go blank

5th � LEDs flicker as network traffic occurs

8. Start up all devices connected to TribeStar.
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Technical Support

Technical Support
Zoom Telephonics is dedicated to providing you with excellent technical support
as well as reliable state-of-the-art products.

Technical Assistance

If you need technical assistance, please have the serial number and the ROM
version of your TribeStar on hand when you call. To locate the serial number,
refer to the illustration in the Unpacking TribeStar chapter. Information such as
the number and types of routers connected to your network, the number of nodes
in your network, their system versions, and the types of servers being used can
help us better understand the dynamics of your network.

You can contact Zoom Technical Support at (617) 753-0700.  Technical Support
hours are 8:30 AM – 5 PM, Monday through Friday, Eastern Time.  You can also
send a fax at (617) 423-5536.

If you have a sales question, contact Zoom Sales at (800) 631-3116.

You can also get information on Zoom products and services at our web site.  The
address is www.zoomtel.com.

Our address is:

Zoom Telephonics, Inc.

207 South Street, Boston, MA  02111
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PART II: Introduction to TribeStar

AppleTalk Fundamentals
This chapter introduces AppleTalk networking concepts that will help you config-
ure your network with TribeStar. If you are an experienced administrator of
AppleTalk networks, you may skip this chapter. If you are a beginning network
administrator, you should read this chapter before installing TribeStar.

AppleTalk Basics
A Local Area Network (LAN) is a group of computers connected together in order
to share data or work collaboratively. While the wires that actually connect the
computers are the most visible element, many other elements are required. For
example, the computers must know how to address each other and they must
agree on basic rules for accessing the wire.

When one computer wants to send data to another, it packages the data into
many small pieces called packets and sends them down the wire separately. This
is so that no one device can monopolize the network. It also means that every
packet must contain the destination address and other information important for
packet delivery.

LocalTalk and Ethernet define a standard for the actual physical wires, or media
that connect the computers, the character of the electrical signals that are trans-
mitted, and the basic rules used to control access to the wire. Built into every
Macintosh and accessed through the printer port, LocalTalk transmits data at the
rate of 230,000 bits per second, or 230 Kbps. Ethernet, by contrast, transmits at
the rate of 10 Mbps (that’s 10 million bits per second).

Invented by Apple Computer in 1983, AppleTalk is a set of software protocols.
Protocols define a framework for communication between computers. Compared
to media, protocols are concerned with higher level issues, such as packet
addressing. Relative to other protocols, AppleTalk is distinguished by its ease of
use.

AppleTalk Addressing

One of the most important features of the AppleTalk protocol suite is the way that
it allows nodes to be addressed. Within a small group of computers, nodes are
identified by a number between 1 and 253, called the node number . This is the
first tier of the AppleTalk address.

A larger AppleTalk internet  requires more organization. It needs a second tier for
address information. This is called the Network Number or Network Number
Range.  A LocalTalk network always has a single network number allowing for a
theoretical maximum of 253 devices per network. An EtherTalk network is identi-
fied by a network number range, e.g., 50-60 or 100-100, potentially allowing for
many more than 253 devices in one network. An AppleTalk network number can

II. Introduction to TribeStar
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be between 1 and 65,535. The network address is conventionally written such
that the network number and the node number are separated by a decimal point.
For example, if a Macintosh is on network number 61 with node number 112 its
network address is written as 61.112.

Routers organize groups of nodes into one network number or network number
range and forward packets to the destination network. In the next illustration,
follow the packet addressed to 61.112 from the lower figure through the routers to
its destination. Communicating with special packets called Routing Table Mainte-
nance Protocol packets (RTMP), each router builds a list of network numbers that
can be reached from each of its ports. When a router receives a packet destined
for a network located on another port, it forwards the packet. Routers may
connect networks of similar or dissimilar media.

While a router uses the network number portion of the address to forward packets
within an internet, a bridge uses the node portion of the address to forward
packets directly to the proper node within the local network. TribeStar is a bridge.
A bridge enables a network to operate faster and more efficiently by reducing
contention within the network. (See the How TribeStar Works  chapter for a more
detailed explanation.)

AppleTalk Fundamentals
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AppleTalk Zones
Apple introduced the zone feature so that users can view network resources more
conveniently. Seen by Mac users in the Chooser, zones are groups created by the
network administrator to make it easier for people to navigate around the network.
Zones are defined by routers or by TribeStars. A small company might have
zones called “Sales,” “Production,” and “Finance”. Members of these functional
groups would be found in the Chooser in the appropriate zone.

The network administrator can create one zone for each network or alternatively,

AppleTalk Fundamentals
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one zone may span many networks. An EtherTalk network can have more than
one zone on one network. LocalTalk, however, can have no more than one zone
on a network and as a consequence, all LocalTalk nodes on a particular TribeStar
must belong to the same zone. On an EtherTalk network with more than one
zone, individual Macs choose the zone to which they will belong when they start
up. Zones are configured through routers or TribeStars.

EN Port

TribeStar
zone B

EN Port

TribeStar
zone A

Mac L1 Mac L2

Printer A

Ethernet Mac - E1 Ethernet Mac - E2 Ethernet Mac - E3

Printer B

Mac L3

zone B zone C zone A

Ethernet Machines, including TribeStars, can be in any one of the zones
defined on the network. Looking in zone A from any Mac’s chooser will
show printer A and Macs L1 and E3 (assuming file sharing is turned on).
Similarly, looking in zone B will show printer B, Macs L2, L3, and E1 and
looking in zone C would show only Mac E2.

On EtherTalk, each network has a default zone. Whenever a node is unsure
about its zone, it places itself in the default zone. The default zone is also speci-
fied by the network manager through the router or TribeStar management soft-
ware.

 MacIP

TCP/IP is another popular protocol suite. Developed to network UNIX computers
at research and education sites around the country, TCP/IP is the protocol used
for the Internet, the world’s largest computer network. The growth of the Internet
has fueled the development of many applications, such as electronic mail and
information search and retrieval software.

TCP/IP, however, cannot be carried directly by a LocalTalk network. The MacIP
protocol was developed to remedy this situation. By encapsulating TCP/IP
protocols inside AppleTalk, MacIP allows LocalTalk nodes to access TCP/IP
services such as e-mail, Telnet, or FTP (File Transfer Protocol). This allows
LocalTalk Macs to participate on the Internet like any other machine running TCP/
IP. MacIP is an option on TribeStar. (See PART V: TribeStar IP  for further infor-
mation on MacIP.)

AppleTalk Fundamentals
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How TribeStar Works

TribeStar as a Bridge

TribeStar is a multi-port bridge. A bridge performs the filter and forward process
using the node number portion of the network address. While a router delivers
packets across different networks, a bridge delivers packets from node to node of
the same network.

Because TribeStar is a bridge, all of its ports must be on the same network (i.e.,
the network administrator must assign the same network number to its LocalTalk
and Ethernet ports). If TribeStar is connected to a router, the administrator
assigns the network number during the configuration of the router. Then,
TribeStar automatically learns the network number during the start-up process. If
TribeStar is not connected to a router, the administrator need do nothing.
TribeStar uses a factory-preset network number. More details regarding assign-
ment of network numbers are given in the AppleTalk Configuration chapter.

Recall in the AppleTalk Addressing  section that the EtherTalk network number
can be a range but the LocalTalk network number must be a single number. For
TribeStar to operate properly, the Ethernet network number must be a range of a
single value. This value will also be the LocalTalk network number. The network
administrator will assign this network number to the TribeStar in the “AT Config”
page of SwitchMonitor.

Packet Delivery with TribeStar

In a TribeStar network, devices (i.e., nodes) are wired into one of TribeStar’s 9
ports using LocalTalk or Ethernet cables. If no routers are present, all nodes are
in the same network. If routers are present, at least two networks are involved,
and packet delivery is more complex.

First, let’s discuss how TribeStar delivers packets within the same network. When
a node transmits, the packet is broadcast to all nodes attached to the same port.
If the packet is destined for another node on the same port, TribeStar ignores the
packet and prevents it from being broadcast to other ports. Meanwhile the packet
has been received by the destination node with the matching network address.
This type of packet traffic is called “local”. (Follow network address 61.49 in the
next illustration.)

Conversely, if the packet is destined for a node on a different port (still within the
same network), TribeStar looks up the destination port in its bridging tables and
forwards the packet to the correct port to be accepted by the appropriate node
there. (Follow network address 61.112 in the next illustration.)

Second, if the TribeStar network is part of an internet joined by routers, a packet
destined for another network is delivered by TribeStar to the port with the router,
which accepts and forwards the packet to its destination network. (Follow network
address 72.53 in the next illustration.)

TribeStar converts LocalTalk packets to EtherTalk packets, and vice versa, when
delivering packets between LocalTalk and Ethernet.

How TribeStar Works
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TribeStar�s Design

TribeStar is a learning bridge. It automatically builds and maintains bridging tables
(which contain all nodes’ network addresses and port locations) by examining the
packet’s source network address whenever nodes transmit. If a node is inactive
for a prolonged period, its entry in the bridging table is aged and eventually
removed. The entry is immediately restored when the node transmits packets.
The bridging tables are cleared when the power is turned off.

TribeStar accomplishes bridging by means of four Zilog Z8 microprocessors and
one Motorola 68340 microprocessor. Running at 18 MHz and 17 MHz respec-
tively, they are fast enough to handle up to eight simultaneous transmissions
between LocalTalk and Ethernet, or four inter-port transmissions among LocalTalk
ports. Buffers store packets destined for busy ports until the ports clear.

A red port LED means that packets are being transferred from a Macintosh into
TribeStar. A green LED indicates traffic out from TribeStar to a Macintosh. A
flashing amber light probably indicates that packets are being received and sent
in quick succession. A solid amber LED indicates that the port is disabled.

How TribeStar Works
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PART III: Installing a Network

Planning a New Network
If you are putting together a network for the first time, this chapter and the next,
Wiring Your Network , are intended to help you design and wire a new single
room network for your TribeStar. This chapter discusses alternative cables for
LocalTalk and Ethernet, then suggests a wiring plan for your network. The Wiring
Your Network chapter outlines the procedure for actual installation of your
LocalTalk and Ethernet wires that will be connected to TribeStar. The principles
discussed in these chapters can be applied beyond one room, but we recommend
that you consult a qualified network cable installer if you plan to wire a larger area.

After your network is wired, refer to the Installing Your TribeStar  chapter to
complete your installation.

Cables for LocalTalk
TribeStar uses standard PhoneNET-type wiring instead of Apple’s shielded
cables. PhoneNET uses one pair of unshielded twisted telephone wires. However,
we recommend that you build your network with two pairs per device, which
enables you to run either PhoneNET or 10BaseT Ethernet. In the future, if you
upgrade the device to Ethernet, you can use the same wires.

If the longest single wiring run between a LocalTalk device and TribeStar is less
than 50 feet, you can use flat silver satin cable  with RJ-11 modular plugs on both
ends. This type of cable is intended to be used with a patch panel wiring kit.

Since the wires inside flat cables are not twisted and are susceptible to interfer-
ence from electrical devices such as florescent lighting and electric motors, for
longer distances you should use station cable which contains twisted-pairs inside
a plastic tubing. This cable has solid copper wires intended to be punched down
to a block on one end and connected to a wall jack on the other end.

PhoneNET-type
connector

Cables for Ethernet

TribeStar’s Ethernet port has a built-in AUI connector that accepts transceivers for
ThickNet, ThinNet or 10BaseT cable. Because it is most similar to PhoneNET-
type wiring, we recommend that you use 10BaseT for easy installation.

III. Installing a Network
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Planning a New Network

ThickNet
ThickNet, or 10Base5, uses a coaxial cable with two layers of shielding. Because
of this, ThickNet is 0.37 to 0.41 inches in diameter and difficult to bend without
damaging the internal wires. ThickNet can span 1,500 feet, support up to 100
transceivers, and is most appropriate as the backbone of a large internet.

ThinNet

ThinNet, or 10Base2, is more flexible and less expensive than ThickNet. It can
span 550 feet and support up to 30 transceivers. To connect devices on ThinNet,
transceivers are daisy chained in one continuous bus through BNC T-connectors,
and must be terminated by 50ý resistors at both ends of the chain. When you add
a device in the middle of the bus, the network goes down because you break the
chain. Also consider that adding BNC connectors to ThinNet cable is slower and
more difficult than crimping RJ-11 or RJ-45 modular plugs onto telephone cable.

Copper
Core

Shielding
layer

BNC
T-connector

BNC barrel
connector

INCORRECT

CORRECT
Terminated or to 
rest of network

Terminated or to 
rest of network
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Planning a New Network

10BaseT
10BaseT, or Unshielded-Twisted Pair (UTP) Ethernet, uses 2 twisted pairs of
telephone wires, but unlike PhoneNET, can not be daisy chained in a bus. Gener-
ally, one uses a 10BaseT hub to connect TribeStar to multiple Ethernet
devices. (See the illustration in the  Wiring Plan section.) To connect a single
device to TribeStar’s Ethernet side using twisted pair requires a special
10BaseT cable in which the transmit and receive pairs are reversed on one
end. (See the illustration in the  Making Your Own Cables section.)  The main
advantage of 10BaseT is its similarity to PhoneNET-type cables in handling and
ease of use. You can use the same flat silver satin cable or station cable for both
LocalTalk and Ethernet segments. If you later upgrade a device to Ethernet, your
10BaseT hub can accept the existing cables. You only need to replace the RJ-11
plugs with RJ-45 plugs, and where needed, the wall jacks.

RJ-45 modular connector

2 pairs of
twisted wires

Connecting Macs to Ethernet

Connecting a Mac to Ethernet requires an Ethernet card — either Apple’s built-in
card (available on higher-end Apple machines) or one of various third-party cards.
Apple’s cards require an AAUI to ThinNet or 10BaseT transceiver (often referred
to as “friendly net” transceivers). Third party cards may have built-in transceivers
and connect directly to ThinNet or 10BaseT, or they may require an AUI to
ThinNet/10BaseT transceiver, as does TribeStar.

Wiring Plan

TribeStar’s LocalTalk ports connect to all devices through one 50-pin RJ-21 cable.
This cable, in turn, is connected to either a patch panel or a punchdown block.
(See Cables for LocalTalk  section.) In either case, you can connect 4 branches
per port via the patch panel’s 4 modular jacks or the punchdown block’s 4 sets of
clips. This gives you a maximum of 32 LocalTalk branches among 8 ports.

For maximum flexibility, we recommend that you wire one device per branch. Only
if you have more than 32 devices should you daisy chain two or more devices per
branch. While this “home run” wiring plan uses more wire, it also gives you
maximum control over the network. For example:
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Planning a New Network

� While troubleshooting, you can gradually connect devices to a port. The
last added device that causes the port to malfunction is probably
defective or is attached to bad wiring.

� You can disconnect a malfunctioning branch or device without affecting
any other device on the same port.

� You can balance the traffic pattern so that each port handles roughly the
same amount of network activity by moving heavy network users to
under-utilized ports. See the SwitchMonitor: Managing Your Network
chapter for methods of analyzing packet activity levels. Since each user
has one branch, you can easily rearrange the users by moving the
branches around the patch panel or punchdown block.

� You can selectively upgrade a device to Ethernet without having to
upgrade all devices daisy chained to its branch.

TribeStar’s Ethernet port, via a transceiver, connects to a 10BaseT hub. A
10BaseT hub allows only one device per port, so you must use the home run
wiring plan. If you use station cable which is punched down to a block, be sure to
purchase a 10BaseT hub that can interface with a punchdown block.

10BaseT
Hub

Patch panel

50-pin
    RJ-21
      cable

Homerun wiring

Daisy-chain wiring
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Wiring Your New Network
This chapter outlines the procedures for wiring a new single room network. We
will demonstrate a simple wiring scheme with surface (i.e., external) wiring of level
four unshielded twisted pair (UTP) cable for both LocalTalk and 10BaseT
Ethernet. If you plan to wire a larger area, use in-wall wiring, or use station cable,
we recommend that you consult a qualified network cable installer. If you need
more information than described here, an excellent book for you to read is the
MacWorld Networking Handbook by Dave Kosiur and Nancy Jones, published
by IDG Books in San Mateo, California (telephone 1-800-762-2974).

The following are the procedures for wiring your network. (While we use a patch
panel in our example, the same principles may be applied to a punchdown block):

1. Buy or make and test your LocalTalk and Ethernet network cables.

2. Connect LocalTalk connectors to your LocalTalk devices.

3. Use your network cables to connect devices to the patch panel.

4. Plug the LocalTalk patch panel into TribeStar via the 50-pin RJ-21 cable.

5. Plug the 10BaseT transceiver into TribeStar and connect it to your Ethernet
hub.

6. Power up TribeStar, then turn on all devices according to the Installing
TribeStar chapter.

Ethernet Macintosh

Thinnet Transceiver

LocalTalk
Macintosh

PhoneNET-type
LocalTalk connector

TribeStar

Patch panel

50-pin
  RJ-21
    cable

COMPUTER  WORKS

COMPUTER  WORKS
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Making your own cables
Purchasing reels of cable, cutting it into needed cable segment lengths and then
crimping modular plugs onto the ends is probably the most economical solution to
wiring a small network. To make your own network cables, you need UTP cables,
plugs and crimpers for RJ-11 and RJ-45 jacks. To test your finished cables, you
need an ohm meter and two modular taps (one for each plug of the cable). All
these materials can be purchased at a telephone wiring store.

First, measure the distance between a device and the TribeStar or 10BaseT hub.
Then cut the cable to length. Write the name of the device on masking tape and
then place the identifying tape on both ends so you can later identify this cable in
the network. Be sure to leave some slack so that your wire can reach both
TribeStar and the 10BaseT hub if you later upgrade that branch to Ethernet.

Use the crimper’s built-in stripper to trim away the outer jacket of the cable but do
not strip the wires. Place the wire ends into the blank plug and insert it into the
crimper. When you squeeze the handles, the crimper drives the plug’s pins
through the wire’s insulation to contact the wires. Also, when inserting the cable
end into the plug, be sure to push the outer jacket in far enough to be firmly held
when crimped. Follow the figure below to match the correct color wires with the
right pins for RJ-11 or RJ-45 plugs. Repeat the process for the other end of the
cable.

If you want to connect only one Ethernet device (e.g., a file server) directly to the
TribeStar, follow the special cable illustration to make a special 10BaseT cable in
which the Transmit and Receive pairs are reversed.

All 4 wires in LocalTalk cables can be used for 10BaseT. Only the two wires on
either side of the center pair of wires are used by LocalTalk connectors. In the
standard telephone wires, these are the yellow and black wires.

BlackYellow

Green Red

Yellow
TD+

Green
TD–

Red
RD+

Black
RD–

RJ-11
modular plug

RJ-45
modular plug

Active wires in Network

NOTE: The colors of your wiring may differ
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Red
TD+

Black
TD–

Yellow
RD+

Green
RD–

Reversed RJ-45 plug

Yellow
TD+

Green
TD–

Red
RD+

Black
RD–

Normal RJ-45 plug

Active wires in Network

1 8 1 8

Special cable for connecting a single Ethernet device via 10BaseT

Testing Your Finished Cables

To test the finished cable, you will need 2 modular taps and an Ohm Meter. Plug
both ends into the modular taps. (See the next illustration.) Without the modular
taps you can not easily touch the plug’s pins with your ohm meter. Use the ohm
meter to check first for opens (infinite resistance) across pins of the same plug,
then for continuity across the same pin number between the two plugs. While
testing for continuity, stress the cable by wiggling it near the plugs. This assures
that you have made a solid connections between the wires and the pins.

According to the MacWorld Networking Handbook , the most typical problem
with making your own cables is related to faulty crimping. Cheaper crimpers do
not always push the pins past the insulation, resulting in intermittent network
connections that are very difficult to detect and correct. We recommend that you
invest in the best crimper you can afford.

Ohm

on/off

–

+

14
3 2

5
6 7

8

Modular Tap

Modular Tap

Finished
network
cable

14
3 2

5
6 7

8

0.01



23TribeStar User�s Guide

Wiring Your New Network

Connect all Devices to Patch Panels
Plug a PhoneNET-type LocalTalk connector into the printer port of each LocalTalk
device. Be sure to terminate the end of each branch. (See the next illustration.)

Then, use your network cables to connect LocalTalk devices to the LocalTalk
patch panel. It is wise to collect all your cables into bundles. This makes taping
them down much easier. It is a good idea to maintain a chart next to the panels to
show devices and their port-branch location.

Patch panel

PhoneNET-type
LocalTalk connectors

Terminating
resistor

Plugging an RJ-21 Cable into TribeStar
Plug the LocalTalk patch panel into TribeStar via the 50-pin RJ-21 cable. The RJ-
21 connector is not symmetrical, so you must orient the cable correctly. For the
TribeStar, the orientation is correct when the cable points away from the LEDs.
Secure the cable with the Velcro strap.
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50-pin
  RJ-21

    cable

Plug in the Ethernet Transceiver

If you purchased the transceiver from Tribe, the DIP switches on the transceiver
have been set to work with TribeStar. If not, consult their instructions for the
proper setting.

TribeStar’s AUI connector is equipped with a latch to secure your transceiver in
place. Slide the latch to the left, the open position. Plug in the 10BaseT trans-
ceiver, then close the latch by sliding it to the right. The latch is properly engaged
if you can not remove the transceiver. You can now connect TribeStar to the
Ethernet device or hub, and you are ready to proceed to the Installing TribeStar
chapter.

Latch open. Slide ->  to close.

Latch closed
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PART IV: Configuration

AppleTalk Configuration
Please be sure that you understand the material in the AppleTalk Fundamentals
and How TribeStar Works  chapters before proceeding. It is important to under-
stand the basics of AppleTalk and TribeStar’s operation before configuring your
TribeStar.

Before you actually set the configuration for TribeStar, you should know the
answers to the following questions:

• Is there a LocalTalk or Ethernet router on the network?

• If so, what are the network numbers and zones configured in the router(s)?

• Is the Ethernet network number set as a range of one (i.e., 61-61)?

It is a good idea to self-test the TribeStar before installing it in your network. While
still disconnected from the network, plug in the TribeStar and observe the pattern
of lights on the front. All the lights should come up all amber, alternate red and
green, turn all red, and then turn off. This test pattern will occur quickly. This
indicates that the TribeStar has passed its self-test. If the lights do not come on or
if they show a very different pattern, contact Tribe Technical Support. (See the
Technical Support chapter in PART I.)

SwitchMonitor for AppleTalk Configuration

TribeStar configuration is accomplished through SwitchMonitor management
software. Please read the SwitchMonitor: Managing Your Network chapter
before configuring TribeStar. This chapter contains essential information for the
configuration process.

To reach the AppleTalk configuration screen, launch SwitchMonitor, select the
desired zone to search, and select a TribeStar for management. SwitchMonitor
defaults to the “Statistics” screen. Click on the pop-up display menu and select
“AT Config”. The top of the window contains the AppleTalk Configuration data.
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Configuration Parameters
This section describes the AppleTalk configuration parameters. The following
sections describe how to configure TribeStar in a variety of different situations. All
parameters are accessed through the “AT Config” screen of SwitchMonitor.

Hard-seed/Soft-seed

The distinction between hard-seed and soft-seed is very important. During start-
up, a soft-seeded TribeStar will ask other network devices such as routers or
hard-seeded TribeStars for their network number and zones list. If other devices
respond with information that conflicts with the TribeStar’s current configuration,
TribeStar will defer to those devices and will replace its configuration data with
what it has discovered from the other devices. If no other devices respond, then
TribeStar will take the configuration as shown in the “AT Config” screen.

A soft-seeded TribeStar will only adjust its configuration to conform to routers or
other TribeStars at start-up. Thus, If you are connecting TribeStar to an existing
network, turn on TribeStar only after it is connected to the network.

A hard-seeded TribeStar will insist on using the configuration data entered
through SwitchMonitor — even if that information conflicts with other network
devices. The network may crash if you bring up a hard-seeded TribeStar into a
network with a router or other TribeStar that is configured with conflicting informa-
tion. If you hard-seed TribeStar, you must be sure that all configuration informa-
tion is consistent among both TribeStars and routers.

Each seed option has advantages. Soft-seeding makes it easier to propagate
changed network configuration among network devices. For example, If you
reconfigure a router, a soft-seeded TribeStar will acquire the new network infor-
mation upon restart. The changes will propagate automatically.



27TribeStar User�s Guide

AppleTalk Configuration

Some network managers prefer hard-seeding because it can add stability to the
network. For example, if a power outage causes all network devices to restart
simultaneously, a hard-seeded network may be more stable than a soft-seeded
network.

HINT: If you want to use hard-seeding, you may bring up TribeStars in soft-seed
mode so that each will garner the correct information from other hubs, then hard-
seed them once you have verified that the correct configuration has been
gleaned. Soft-seed is the default setting.

Network Number (Net)

TribeStar will use this value as the network number. If you do not have a router,
you may use the default value of 1 or choose another number between 1 and
65280. If you have a router and TribeStar is soft-seeded, it will be automatically
set by the router as TribeStar starts up. If you have a router and TribeStar is hard-
seeded, you must enter the same network number that the router is configured
for.

Node Number
TribeStar will use this value as its node number. Normally, it is not necessary to
specify the node number. TribeStar acquires a node number through a dynamic
process at start-up. If you set this manually, make sure that you choose a number
between 1 and 253 and that you have not chosen a number already in use by
another node on the network. The node number is the only configuration param-
eter not subject to hard-seeding. In other words, if you choose a number that
conflicts with another device, TribeStar will always pick a new number anyway.

Zones
The zones dialog box allows the network administrator to configure the Ethernet
backbone with multiple AppleTalk zones, select an Ethernet default zone, and
select a zone for the TribeStar LocalTalk nodes. Zones may be added, renamed,
or removed. TribeStar can handle up to 16 zones on its EtherTalk port. If you have
an Ethernet router and TribeStar is soft-seeded, it will automatically acquire the
zone list at start-up, and TribeStar will be placed in the default zone.

If you ever remove or change the zone in which the Macintosh running
SwitchMonitor is located, you must “toggle” the connection in the Network Control
Panel or restart your Mac.

IMPORTANT NOTE: If you have a LocalTalk router, you cannot connect
TribeStar to an Ethernet network with more than one zone. Doing so will
cause erratic network behavior.
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Setting Changes to the Hub

Before leaving the configuration window, you must press “Set” in order to send the
new configuration to the TribeStar. Changes will not actually take effect until the
TribeStar is rebooted. Choose “Reset TribeStar” from the Options menu to do
this. Choosing “Reset TribeStar” is not the same as shutting off the device and
should not be confused with this.
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SwitchMonitor: Managing Your Network
The successful operation of a local area network depends on the proper installa-
tion and use of the networking hardware. The SwitchMonitor program can be
used to aid in the setup, debugging and management of your TribeStar network.
By providing you with a concise summary of network activity, user activity, port
status, configuration and a diagnostic log, SwitchMonitor offers the information
you need to keep your network operating smoothly.

Getting Started with SwitchMonitor

Before using the SwitchMonitor software, make a backup copy of the original
disk. The SwitchMonitor application may be run on any Macintosh on the internet.
Before launching SwitchMonitor, you must copy it from the floppy disk to your
hard disk, as it will not work properly if launched from a floppy disk. To do this,
simply click on the SwitchMonitor icon, drag it to your hard disk icon, and release.
When SwitchMonitor is launched, it creates a file called “SwitchMonitor Prefer-
ences” in the (System 7) preferences folder.

Selecting a TribeStar for Analysis
To run SwitchMonitor, simply double-click on its icon. You will be greeted by the
Network Search window, which displays the zones of your AppleTalk internet.
SwitchMonitor automatically highlights the zone your Macintosh is in and
searches for all TribeStars and LocalSwitches in that zone. You can select the
desired TribeStar by double-clicking on its name or by highlighting it and clicking
the Select button. A new window bearing the TribeStar’s name appears with
packet statistics for the selected TribeStar.
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SwitchMonitor Screen Summary
Once a TribeStar is selected, a new window opens which allows you to view and
control various aspects of its operation. The Display Menu offers five options:

� “Statistics”: view network traffic on a per port basis, including error packets
and bandwidth utilization.

� “Network”: view a list of network devices and their port location.

� “Diagnostics”: view the internal diagnostics log.

� “AT Config”: configure TribeStar for AppleTalk; disable and store comments
about each port.

� “IP Config”: configure the TribeStar for MacIP.

The Options menu allows you to change the statistics screen update interval, set
hub names, show all sockets in the network screen, set and remove hub pass-
words, download new ROM images, restart TribeStars, and search the network
for zones and TribeStars.

AppleTalk and MacIP Configuration

For information about the “AT Config” screen, see the AppleTalk Configuration
chapter. For information about the MacIP configuration screen, see TribeStar IP
Configuration  chapter.

The Statistics Screen
When you first select a hub in the Network Search screen, you see the Statistics
screen. The frequency at which the statistics are updated can be changed
through the “Set intervals...” selection in the Options menu. Be aware that an
extremely short update interval (one second or less) will cause more network
traffic and may distort the statistics you want to scrutinize.

Displayed for each port are the number of packets received and sent, and the
number of errors since the TribeStar was last cleared. The Clear button allows
you to reset these statistics. The bar display indicates the utilization of each port
as a percentage of the available channel bandwidth. If you have a color monitor,
the green part of the bar indicates the percentage of inter-port traffic, and the blue
part indicates the percentage of local traffic.

The Error column measures the number of corrupted packets. Error packets may
be caused by faulty wiring or a malfunction in the device generating the data. If
the number of errors divided by the number of packets received on a particular
port exceeds 1%, you should check the wiring and termination on that port.
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The Network Screen
To view the network map of devices connected to TribeStar, select the Network
option in the Display menu. This display is useful for checking network integrity.

If you have non-System 7 Macs, be sure each has an AppleTalk version that
includes a Responder init in its System Folder so that they can appear properly on
this display.
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The network devices are listed per TribeStar port by ascending node ID number.
All devices on this TribeStar’s LocalTalk ports are listed in the TribeStar’s zone.
Ethernet devices may be in any zone available on the Ethernet segment.
LocalTalk devices connected to another TribeStar will show up as if they were
Ethernet devices in the same zone as that other TribeStar.

Macs and servers often have several processes that access the network. These
“sockets” show up as multiple listings for the devices node ID. Select “Hide
multiple sockets” from the Options menu to list only the first socket for each
device (usually the socket with the Mac’s name).

The network list shows all devices that can be seen from the machine on which
you are running SwitchMonitor. This list is mapped to the TribeStar’s bridging
tables to determine which port they are connected to. If a device shows up only as
“????”, this means that TribeStar knows of it but it is currently not visible from this
Mac. This could be for one of several reasons:

1. A device is there but doesn’t know how to respond to the search request. It
may be a System 6 Mac without the Responder init installed or a router that
is not “homed” on this network.

2. A device was turned off less than 20 minutes ago and TribeStar has not yet
“aged” the node number out of its bridging table.

If the above are eliminated as possible causes, one might suspect unusually
heavy traffic or wiring problems preventing the machine from receiving or re-
sponding to the search requests at this time.

The Diagnostics Screen

In case you need technical support, the diagnostic log is a powerful tool. Select
the Diagnostics option in the Display menu to view the log. When TribeStar is first
booted up, the start-up sequence is printed to the log and any configuration
conflicts detected will be noted. If necessary, print and fax the log to Zoom at
(617) 423-5536, “Attention Tech Support,” for detailed analysis.

Controlling TribeStar Ports
Select the AT Config option in the Display menu to control the TribeStar ports.
Clearing the Enable box for a particular port immediately disables it from receiving
or sending packets. This may be useful to isolate a faulty network device, but be
careful about disabling a port that is in use. A disabled port will show a solid
amber LED.

In addition, comments may be entered for each port as a note for remembering
how each port is connected into the network. Comments entered here are saved
automatically. If you run SwitchMonitor on another Macintosh, copy over the file
“SwitchMonitor preferences” located in the Preferences folder (System 7). This
file stores all preference information and port comments for your TribeStars.
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Security Configuration
SwitchMonitor allows you to password protect individual TribeStars. After select-
ing a TribeStar, choose “Set Password” under the Options menu. Once you set a
password, SwitchMonitor will prompt you for it every time you try to select it from
the Network Search screen. You may change or eliminate the password with
options offered under the Options menu.

Write down your password(s) in a safe place. If they are lost, you may have to
return your TribeStar to Zoom Telephonics for service.

Downloading ROM Image Updates

New ROMs can be downloaded into TribeStar by following this procedure:

1. It’s best to perform a ROM download from a Macintosh that is directly
connected to a TribeStar LocalTalk port and when your network traffic is at a
minimum. While downloads may be accomplished from Ethernet, they may
be less reliable.

2. Before opening your SwitchMonitor program, verify that it has at least 1200K
of memory allocated to it. This information can be obtained by selecting “Get
Info” from the File menu.

3. Close other programs you may have running on your Macintosh. Open
SwitchMonitor, select the appropriate zone, and double click on the desired
TribeStar. Select “Hub” in the menu bar and select “Download ROM”.

4. Find and open the appropriate ROM file. A message will appear indicating a
successful download. If the bar freezes, the download was not successful.
“Power-cycle” the TribeStar and attempt again.

5. Follow the directions in the AppleTalk Configuration  chapter to bring up the
TribeStars in your network.

6. If unsuccessful, call Zoom Technical Support at (617) 423-5536

Optimizing Network Performance

An efficient network allows users to access remote services or resources quickly
and easily. The statistics display of SwitchMonitor shows the cumulative traffic on
each of the ports of a TribeStar, as well as the average activity over any desired
measurement interval.

A busy port (i.e., one whose Received Packet count is much higher than other
ports’, usually exceeding 25% of network activity) indicates that the resources
connected to it are being used heavily. To optimize performance, try distributing
multiple devices on a congested port among less used ports to reduce the traffic
on that port. If a single device, such as a file server, is connected to a highly
active port, it might be necessary to upgrade this a machine to Ethernet or to add
more file servers to accommodate a growing load.

By setting the update interval (choose “Update interval...” in the Options menu) to
a long value, such as 15 minutes, a good sense of the average network traffic
may obtained. A balanced traffic pattern is important to an efficient network.
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Saving Statistics Over Time
To get a better indication of how your network performs over time, a statistics file
may be opened to record network activity on the ports of a TribeStar. Select the
“Open Statistics...” command in the File menu. After a caution note, proceed to
the file dialog box, which will enable you to open a new statistics file.
SwitchMonitor must be left running in a MultiFinder partition or under System 7 in
order to collect statistics over time.

The statistics file is a tab delimited document which may be imported into a chart
program or spreadsheet to produce an activity chart similar to the one at the end
of this section. Each line of the file contains the following data:

DATE

TIME

Ð time (measured in milliseconds)

PORT 1 switched packet count (sent and received)
PORT 2 switched packet count

...

PORT 8 switched packet count

PORT Ethernet switched packet count

<blank>

PORT 1 local packet count;

...

PORT Ethernet local packet;

Each line is a data sample taken from the TribeStar to allow you to track shifting
traffic patterns over time. Samples are recorded at the intervals specified on the
Statistics page. Therefore, the “Ð time” field should be used to indicate how much
time elapsed from the previous reading to the present one.
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Maintain Network Reliability w/

Switch Monitor
The Network display in SwitchMonitor may be used to check the basic integrity of
an installation. The names of your network devices will appear here, along with
the port to which they are connected. If trouble develops on a remote device,
check this display first. If the machine in question does not appear on this display,
basic connectivity has not been established. If the device is a Macintosh, make
sure that the Responder init is installed in its System Folder. Otherwise, use the
Statistics display to analyze the connection.

The Statistics display will show the reliability of a link. A port with a large number
of Error packets indicates that the wiring to it may be suspect. Check to make
sure that all connections from the port to the remote devices are stable and that
the wiring is correctly terminated. Under normal conditions, a small percentage of
error packets may be expected, however, if lost packets exceed 1% of the total
received packets, a larger problem exists and should be investigated.

HINT: After installing a new network, make notes about each port of the TribeStar
on the Configuration display of SwitchMonitor. This allows you to keep track of
your network wiring if problems develop.

Other SwitchMonitor Functions

SwitchMonitor gives you the ability to save an AppleTalk or MacIP configuration
and load it back into TribeStar at a later time. While in the “AT Config” or “IP
Config” screen, select “Save Config” or “Load Config” in the file menu. In addition,
hub names may be changed from a screen accessed under the Options menu.
Finally, SwitchMonitor screens may be printed with the print command under the
File menu.
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Configuration Scenarios
TribeStar’s installation procedure depends on whether or not you have a router in
your network. If you do, you need to gather the information below:

• network number

• zone name(s) on the TribeStar network

NOTE: Sometimes it is not clear that a network device is a router. For example, a
Shiva LanRover/E™ or a NetWare server may be an Ethernet router. If you are not
sure whether a particular device acts like a router, check its manual.

Networks without any routers

EN

Network 1 - 1

Network 1

Zone name = Default Zone

EN

Network 1

1. Turn off all nodes to be connected to TribeStar.  This is necessary so that
nodes can learn the correct network number and zone name when they start
up again. It is especially critical that EtherTalk nodes are restarted.

2. Connect TribeStar to the LocalTalk side of the network.  Do this by
connecting the RJ-21 cable into the front of the TribeStar and turn it on. Turn
on a single LocalTalk Mac and use SwitchMonitor to configure the desired
network number and specify the zone name(s), if desired. A network with no
routers has no zones defined. By default, TribeStar will define one zone,
called “Default Zone”. You may rename this zone but it cannot be called
zone “*”. Set the new configuration to the TribeStar by clicking the “set”
button, and restart the TribeStar from the Options menu. After the restart,
verify that TribeStar has the correct configuration. Then power off TribeStar.

NOTE: You may put each TribeStar in its own zone, and create as many zones as
you want for Ethernet based devices on your network. See the Zones section in
PART IV for more information on this.

3. Connect TribeStar to the Ethernet side of the network. Attach the
Ethernet transceiver to the back of TribeStar. Then turn TribeStar on again.
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4. Restart all nodes.  Upon start-up, all nodes should receive the correct
configuration information from TribeStar. Verify this by checking to see that
LocalTalk devices can see EtherTalk devices in the Chooser and vice versa.
If this is not the case, restart the TribeStar (now that all nodes are powered
up) and check the “AT Config” page again.

HINT: If any values have changed, it means that there is a router on your network.

Networks w/ Ethernet routers & no

LocalTalk routers
1. With the power off, connect the TribeStar to Ethernet. Then turn on

TribeStar.  During the start-up process, TribeStar learns the network number
and local zone names from the Ethernet router. To confirm that this process
has occurred correctly, run SwitchMonitor from a Macintosh on Ethernet.
Look for the TribeStar in the Ethernet default zone. (The default zone name
is specified in the configuration of the Ethernet router.) Check to see that
TribeStar has gotten the correct network number and zone list. If you cannot
find TribeStar through SwitchMonitor or if the information in TribeStar’s
configuration is different than for the router, disconnect TribeStar from the
network and manually configure it to be consistent with the router. (See
above.)

2. Choose the TribeStar’s zone.  While you are looking at the zone list in
SwitchMonitor, select a different zone for the TribeStar as desired. This is
the zone in which all LocalTalk nodes connected to the TribeStar will appear.
Click “Set” button in AT Config page and then “Reset TribeStar” in the Hub
menu.

3. Connect the TribeStar to LocalTalk. Restart all LocalTalk nodes.  You
must restart all LocalTalk nodes because they must acquire new network
information from the Ethernet router. If you do not restart these nodes, they
many not be visible to the rest of the network. After restarting the nodes,
confirm with the chooser that Ethernet nodes can see LocalTalk nodes, and
vice-versa.

Networks w/ LocalTalk routers & no

Ethernet routers
If your network has a LocalTalk router but no Ethernet router, you may follow the
following procedure. If you have a LocalTalk router, your Ethernet must have
only one zone.

1. Turn off all EtherTalk nodes to be connected to TribeStar.  This is neces-
sary so that the EtherTalk nodes can learn the correct network number and
zone name from the LocalTalk router when they start up again.

2. Connect TribeStar to the network and turn it on.  Connect the RJ-21 plug
into the front of TribeStar and the Ethernet transceiver to the back of
TribeStar. Turn on the TribeStar.
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3. Restart all EtherTalk nodes.  Upon start-up, all nodes should receive the
correct configuration information from the LocalTalk router. Verify this by
checking to see that LocalTalk devices can see EtherTalk devices in the
Chooser and vice versa.

NOTE: For optimum performance and reliability, do not place LocalTalk routers or
LocalSwitches on TribeStar’s port 1.

Networks w/ Ethernet routers & LocalTalk routers

If your network has both Ethernet and LocalTalk routers, you may follow a proce-
dure similar to the one described in the Networks with Ethernet routers & no
LocalTalk routers  section, except that you may not have multiple zones on the
Ethernet. Configure the Ethernet router and the TribeStar for only one zone. If you
create more than one zone, the network will operate erratically.

Networks with Multiple TribeStars
If you have a router, add the TribeStars one at a time to the network. If you do not
have a router, configure one TribeStar fully and turn on that TribeStar first. You
may want to hard-seed this TribeStar. Wait at least one minute before powering
up the other TribeStars. This allows the additional TribeStars to gather the
network and zone information from the first TribeStar. You still must open
SwitchMonitor on each TribeStar if you wish to change its zone.

NOTE: We do not recommend connecting TribeStars to each other by their
LocalTalk ports. Performance and reliability are maximized by connecting
TribeStars to the same Ethernet segment.



39TribeStar User�s Guide

V. TribeStar IP

PART V: TribeStar IP

Introduction to TCP/IP Protocols
TCP/IP is destined to be one of the cornerstones of the information age. As
computer networking has evolved over the last twenty years, much of the accu-
mulated knowledge has been incorporated into the TCP/IP protocols. For many
reasons, TCP/IP protocols are gaining momentum as a connectivity standard.

At Zoom, we believe that TCP/IP protocols and Internet connectivity offer advan-
tages to almost any organization. The Internet facilitates global communication,
offers users access to rich sources of information, and exposes them to new
types and sources of information. With TCP/IP, much of the promise of the
Information Age is already here.

The Tribe MacIP option offers a low-cost way for your LocalTalk users to partici-
pate in the revolution. We hope you and your users enjoy and make good use of
it.

TCP/IP Fundamentals

Named after two of the most prominent members of the protocol family, the TCP/
IP protocol suite actually includes dozens of protocols. One of the core protocols,
Internet Protocol (IP) is responsible for sending packets from one network to
another. It routes packets to their ultimate destination through gateways. How-
ever, it does not guarantee that the packets arrive in the proper order or that the
data will arrive intact at the destination.

Transmission Control Protocol (TCP) breaks data into packets suitable for
transmission across the Internet. Moreover, it allows the destination computer to
reconstruct the packet sequence in the same order that they were sent and
verifies that the packets arrive intact and unduplicated. Thus, TCP can be consid-
ered to be a client of IP.

Several of the other important protocols include File Transfer Protocol (FTP) and
Simple Mail Transfer Protocol (SMTP). FTP uses TCP to allow users to transfer
files, while SMTP controls the transfer of mail messages among IP computers.

TCP/IP was originally developed by the Department of Defense in the 1970s for
UNIX computers. For the past twenty-five years, thousands of network research-
ers have collaborated under the auspices of the Internet Activities Board to define
network standards and solve new problems. Nowadays, vendors including Apple,
Novell, and Microsoft have developed interfaces to allow their software to
seamlessly use TCP/IP protocols for network communication.

This chapter is designed to allow you to understand TCP/IP well enough to plan
and configure a simple MacIP network. If you work in an organization that already
has a TCP/IP network, it will help you to understand how the network is organized
and how TribeStar IP and MacTCP fit in.
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TCP/IP and the Internet
The Internet is an international computer network connecting millions of users at
schools, universities, research institutions, government agencies and corpora-
tions. It is most commonly used to access information at remote locations, to
allow colleagues to collaborate in research and development activities remotely,
and to help friends or peers who share similar interests to communicate. In recent
years, the Internet has grown at an astounding rate of 15-20 percent per month!
Millions of educators, students, researchers, and hobbyists have seen the ben-
efits of connecting via e-mail. They have discovered easy access to vast amounts
of information at sites ranging from the National Archives to the NASA; rich tools
for navigating through and sorting the information; and discussion groups focus-
ing on everything from popular TV shows to molecular biochemistry.

IP Addressing

Each node on a TCP/IP network must have a unique address so that packets can
find their appropriate destination. IP addresses are 32 bits in length. For the sake
of convenience, an address is usually broken down into 4 segments of 8 bits (or,
to put it another way, four bytes). An IP address could be written in binary:

11000110.00110001.00000101.00000101

However, it is more convenient to express an address in decimal form:

198.97.69.5

Every node on a TCP/IP Internet has such an address. Unlike AppleTalk, an
address is usually assigned manually to a specific device.

If a network consisted of only a few dozen computers, we could stop here.
Computers would just send packets directly to each other using the IP address.
However, when thousands or millions of nodes are connected together, additional
levels of organization improve performance, reliability and ease of administration.

Networks are blocks of addresses within which computers can send packets
directly to each other. When packets need to go to a computer outside the
network, a device known as a gateway , or router , knows where to send a packet
to advance it towards its final destination.

A certain number of the top bits of the IP address represent the number of the
network to which a particular node is attached. This is called the network seg-
ment . The rest of the bits represent the host portion  of the address. When a
node wants to send a packet, it compares the network segment of the destination
address to its own network segment. If they are the same, the sending node can
address the packet directly to the destination. If they are different, the sender
forwards the packet to the default gateway  on its network.
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Network 1

Router

1.4 1.2 1.1

2.5 2.3 2.12.2

Network 2

2.4

1.3

Device 2.1 sends to 
1.4 via router 2.4 (1.3

Device 1.1 sends  
directly to 1.2.

Figure 1. Network with a 3-bit address

Figure 1 above illustrates the principal of IP routing in a simple network. The
Internet works under the same principal, except that the total address is 32 bits,
and the dividing line between where the network address ends and the host
address begins is flexible.

The Internet Network Information Center hands out several different types of
network address ranges to organizations depending on their size. A Class A
network address uses only the first byte to identify the network, and the remaining
three bytes to identify the node. The first node of a Class A address falls in the
range 1-126. For example, address 100.5.7.25 identifies node 5.7.25 on network
100. There are only 127 Class A addresses, but each will support a very large
number of nodes.

A Class B  network address uses the first two bytes to identify the network, and
the last two bytes to identify the host. The first byte of a Class B network is a
number in the range 128 - 191. For example, address 145.200.26.14 identifies
node 26.14 on network 145.200. There are about 16,000 Class B addresses
available.

Finally, a Class C  address uses the first three bytes to identify the network, and
the last byte to identify the host. The first byte of a Class C network is a number in
the range 192 - 255. For example, address 198.97.64.101 identifies node 101 on
network 198.97.64. There are about four million Class C addresses available,
each with up to 253 host addresses.

IP networks use a mask to indicate which portion of the address is used for the
network address and which portion is used for the host address. In the mask,
every bit that is dedicated to the network address is set to one while every bit that
is dedicated to the host address is set to zero. The subnet masks for Class A, B,
and C networks are shown in figure 2.

Allocation of Bytes

A

B

C

1

2

3

3

2

1

Network Mask

255.0.0.0

255.255.0.0

255.255.255.0

Address
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Figure 2. Allocation of bytes for Classes A, B and C

IP Subnetting

The method of dividing IP address space into Class A, B, and C allows the
Internet organizers to allocate addresses in an organized manner. It also enables
the construction of an efficient hierarchy of Internet routers designed to direct
packets to their destination organization. Another feature, IP Subnetting , allows
network administrators to further partition address space in a similar way.

There are many reasons why networks are more manageable, reliable and
efficient when routers subdivide them into clusters of several dozen to several
hundred nodes. For example, TCP/IP nodes sometimes broadcast packets that
are really only relevant to one node. The more nodes directly connected to a
network, the more nodes that must receive and process such packets. Among
other things, subnetting improves the efficiency of the network by limiting the
scope of broadcast packets.

IP subnets are created with the top bits of the host portion of the address:

XXXXXXXX.XXXXXXXX.YYYYYYZZ.ZZZZZZZZZ

Network Portion Host Portion

Subnet Portion

Figure 3. Example of subnetted network

When a subnet is used, the mask is no longer as simple as with a Class A, B, or
C network. In the above example, some bits of the third byte are used for the
network address; other bits are used for the host address. Six of the eight bits are
used for the network, while two of the eight bits are used for the host portion of
the address. Therefore, the subnet mask for the above network would be
255.255.252.0.

An example will clarify how subnets are created. Consider Williams Construction
Inc.’s Class C network: 199.66.33.0. If the network is not subnetted, all nodes will
consider themselves to be on the same network and all nodes will receive broad-
cast packets:

Williams Construction’s network administrator, Jane Packet, has just learned
about IP subnetting. Williams Construction’s campus has three buildings, with
about 40 Macintoshes in each. Jane realizes that if she were to use the top two
bits of the host byte (the fourth byte is the only one used for host addresses on a
Class C network address), then she could create four subnets. After using the top
two bits for the subnet, she has six bits to use for the host portion of each subnet,
or up to 64 host addresses on each subnet. Each of the three buildings can use
one subnet, and the backbone that connects them all can use the fourth.

There are four possible combinations in the top two bits. The seventh bit (or the
least significant bit of the subnet) corresponds to 64 in decimal notation. There-
fore, each subnet increments by 64 in decimal notation. To create such a network,
Jane will need a router for each of her buildings. Her network will look like this:
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RA R B R C

199.66.33.193

199.66.33.1

199.66.33.194

199.66.33.65

199.66.33.129

199.66.33.195

Bldg 1 Bldg 2

Bldg 3

Host A
199.66.33.5

Host B
199.66.33.77

Subnet: 199.66.33.64
Subnet mask: 255.255.255.192

Subnet: 199.66.33.0
Subnet mask: 255.255.255.192

Subnet: 199.66.33.128
Subnet mask: 255.255.255.192Backbone

Subnet: 199.66.33.192
Subnet mask: 255.255.255.192

Figure 4. Example of a subnetted network

Jane uses the fourth subnet for a backbone to connect the buildings together.
Note that the routers must have a different address for each network they are
connected to. When Host A transmits a packet, it is the job of Router A to deter-
mine whether the destination address is located on the same subnet or on a
different subnet. If the destination address is on the same subnet, the router
ignores the packet and the destination address picks it up directly. If the destina-
tion address is on another subnet, the router forwards the packet to the router
which leads to that network.

Follow the progress of Packet A in Figure 4. Router A accepts the packet be-
cause the destination is on a different subnet than the source. Router A has a
routing table which tells it that Host B (199.66.33.77) can be reached through
Router B (199.66.33.194) and therefore forwards the packet to Router B. Router
B then forwards the packet onto subnet 199.66.33.64, where it is picked up by
Node B.

For various reasons, hosts must have an address they can use to broadcast
packets to all nodes on the network. The broadcast address is usually the highest
host address within the subnet. For example, in a class B network: 192.111.0.0,
the broadcast address is 192.111.255.255. Or, in the case of Williams
Construction’s network, the broadcast addresses for the four subnets would be:

Subnet Broadcast Address

199.66.33.0 199.66.33.63

199.66.33.64 199.66.33.127

199.66.33.128 199.66.33.191

199.66.33.192 199.66.33.255

One more point before we conclude our introduction of the TCP/IP protocols:
because hosts must send packets to a router if the destination address is not on
the same network, they need to be configured with the address of the “default
gateway.” This is done through UNIX commands or, in the case of a Macintosh,
through the MacTCP control panel.
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The Purpose of MacIP

TCP/IP protocols cannot be carried directly by a LocalTalk network. Because
LocalTalk is not suitable for a large internet, no standard was developed for
carrying any other protocols besides AppleTalk. The MacIP protocol was devel-
oped to work around this problem.

MacIP encapsulates TCP/IP protocols inside AppleTalk packets, allowing
LocalTalk nodes to access TCP/IP services, such as e-mail, Telnet or FTP (File
Transfer Protocol). This allows LocalTalk Macs to participate on the Internet like
any other machine running TCP/IP. Please make sure that you are familiar with
the fundamentals of TCP/IP networking (see previous chapter) before reading this
chapter.

How MacIP Works

On an IP network, hosts forward packets directly to the destination node or to a
router that leads toward the destination. On a LocalTalk network, Macintoshes
must send IP packets encapsulated in LocalTalk to a MacIP gateway which strips
away the AppleTalk packet and forwards along the IP packet. When the destina-
tion IP host responds, the MacIP gateway encapsulates the IP packet into
LocalTalk and forwards it to the Mac on LocalTalk. MacTCP is the Macintosh
application that encapsulates IP packets into LocalTalk and can be obtained
directly from Apple or any of their authorized dealers.

TribeStar acts as a MacIP gateway. Because Macintoshes are not directly on the
IP network, the TribeStar assigns an IP address to a Mac and acts as its proxy
agent on the IP network, collecting all packets destined for the Mac and forward-
ing them encapsulated in LocalTalk. IP addresses may be assigned by TribeStar
whenever a Mac requests one. This is called dynamic addressing . Alternatively,
IP addresses may be configured into the MacTCP application on the Macintosh.
This is called static addressing . The following is a step-by-step description of the
process for acquiring a dynamic IP address and carrying on an IP network
conversation.

1. The Macintosh user (AppleTalk address 61.59) launches an application, say
Telnet. The user wants to Telnet into the UNIX host (IP address
192.33.20.147). Telnet calls on the services of MacTCP to establish the
network connection. MacTCP broadcasts AppleTalk packets looking for a
device of type “IPGATEWAY”.
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EN Port

TribeStar
From: 61.59
To: Router
NBP Broadcast Request for IP Gateway

A

A
   A

   A

Network 61-61

UNIX
host Network addre

192.33.20.147

Network address 61.243

Mac
Network address 61.59

Figure 5. MacIP: Request for IP Gateway

2. TribeStar responds to the Mac, identifying itself as the IP Gateway.

3. If MacTCP is configured to get an address from the server, the Mac requests
an IP address from TribeStar, which consults its table of IP addresses. The
network administrator has previously configured TribeStar for dynamic
addressing and specified a range of IP addresses that it may hand out.
TribeStar finds that 192.33.20.112 is the lowest free address and assigns it
to the Mac.

NOTE: A TribeStar configured for dynamic addressing will always choose the
lowest free address number within its specified range.

4. The Mac receives the new IP address, forms an IP packet, puts an
AppleTalk envelope around this IP packet and addresses the AppleTalk
packet to the TribeStar using the TribeStar’s AppleTalk address.

EN Port

TribeStar From: 61.59
To: 61.243
IP packet inside:
  From: IP address 192.33.20.112
  Request: Login to UNIX host

A(I)

A
 (I)  A

(I)

Network 61-61

UNIX
host Network addre

192.33.20.147

Network address 61.243

Mac
Network address 61.59

Figure 6. MacIP: Send IP packet �inside� AppleTalk

5. TribeStar receives the AppleTalk packet, strips off the AppleTalk envelope
and forwards the IP packet that is inside to the UNIX host. Note that the
source address in the IP packet is the Mac’s IP address even though it came
via the TribeStar.
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EN Port

TribeStar

UNIX
host

From: 192.33.20.112
To: 192.33.20.147
Request: Login to UNIX host

Network 61-61 I   I   I   I   I   I   I   I   I   I   I   I

Network addres
192.33.20.147

Network address 61.243

Mac
Network address 61.59

Figure 7. MacIP: Gateway strips-off AppleTalk portion

6. The UNIX host accepts the IP packet and sends a reply to the Mac’s IP
address.

7. TribeStar sees the IP packet destined for the Mac’s IP address. Knowing
that it is responsible for delivering these packets to its LocalTalk network,
TribeStar accepts the packet on the Mac’s behalf, puts the packet inside an
AppleTalk envelope, addresses the packet with the Mac’s AppleTalk ad-
dress, and forwards the packet to its LocalTalk network.

I   I   I   I   I   I   I   I   I   I   I   I

UNIX
host

EN Port

TribeStar A(I)

A
 (I) A

(I)

Network 61-61

Network addres
192.33.20.147

From: 61.243
To: 61.59
IP packet inside:
  From: IP address 192.33.20.147
  To: IP address 192.33.20.112
  Reply: Login OK

Network address 61.243

Mac
Network address 61.59

Figure 8. MacIP: IP host replies, Gateway encapsulates

8. The Mac accepts the packet, strips off the AppleTalk envelope, and delivers
the IP packet to the Telnet application. The process repeats itself as long as
necessary.

TribeStar can also serve as a MacIP gateway for Macintoshes attached directly to
Ethernet. Nothing changes except the ports that TribeStar uses. In many cases,
network administrators will configure Ethernet Macs to forward IP packets directly
onto the network, bypassing the MacIP gateway. However, some network admin-
istrators find that the dynamic addressing feature of MacIP is a convenient way to
manage a limited range of IP addresses.
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Setting MacTCP Configuration Options
When using Dynamic addressing, simply instruct MacTCP to obtain an address
from the “server”. (This is done inside the MacTCP control panel.) In this case, all
other settings will be filled in when an application launches MacTCP and contact
is made with the TribeStar, which acts as the MacIP gateway.

When using Static addressing, select “manual” in the MacTCP configuration
window and configure MacTCP with the proper address for that node. Consult
MacTCP instructions for details.

Be sure to tell MacTCP in which zone to look for the MacIP gateway. If there
is a gateway in the Mac’s zone, then that zone must be selected in the
MacTCP control panel (i.e., you must use the gateway in your zone if there
is one). Note that the zone names are the same in the sample control panels
shown in the next illustration.
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NOTE: If there is no MacIP gateway in your zone, it is possible to obtain an
address from a gateway in another zone. This is not recommended, however, as
the address will not be reconfirmed if the gateway is restarted.
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TribeStar IP Configuration
Before configuring TribeStar for MacIP, you must know several facts about your
TCP/IP network. You also must decide if you will be using routing or KIP-style
forwarding . Be sure to verify that the addresses you plan to use are not in use by
other IP nodes and that you are planning your IP network in a way that is consis-
tent with the rest of the network.

Before opening the “IP Config” screen of SwitchMonitor, make sure that you have
found or decided on the following information:

TribeStar IP Address: _____

Subnet Mask: _____

Broadcast Address: _____

If you want to find this information out from a UNIX host on your network, use the
netstat -i command to identify your Ethernet interface. Then use the /usr/etc/
ifconfig<interface> command to find the network number, mask and broadcast
address of your IP network.

If you use routing as described in the IP Subnetting  section, you are creating an
IP subnet on which the MacIP nodes will reside. This means that other IP nodes
will not address packets directly to the MacIP nodes. Instead, they will address
them to TribeStar, which will act as a router in forwarding the packets to their
ultimate destination. On the other hand, if you use KIP-style forwarding, the
MacIP nodes appear to be on the same network to which the TribeStar is at-
tached. TribeStar still forwards packets to their ultimate destination, though, it
must perform the encapsulation functions of an IP Gateway. While IP subnetting
allows for somewhat more efficient network operation, KIP-style forwarding is
easier to configure and is fully adequate for small IP networks.

You also must decide if you will have the TribeStar assign IP addresses dynami-
cally or if you will assign a static address to each Macintosh. With dynamic
addressing, TribeStar hands out IP addresses to Macs as they request them.
When the Mac is shut off or if the Mac is not using MacTCP services, that IP
address is free to be assigned to someone else. Dynamic addresses are often
preferred because they allow a limited range of IP addresses to be used more
efficiently. A network administrator may choose to use both static and dynamic
addresses within TribeStar’s client range.

Getting Started

1. Turn on the TribeStar.

2. Start SwitchMonitor and select a TribeStar.
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Figure 9. Select �IP Config� within SwitchMonitor

3.  Click on the “Display:”  menu and select “IP Config.”

4. Check the “Enable MacIP”  box.

IP Routes Parameters
5. Default Gateway:  Enter the address of the default IP gateway. This is the

address of the IP router to which all packets should be sent that are destined
for nodes on other networks.

6. Generate RIP:  You may want to check this box if you have chosen routing.
RIP packets , or “Routing Information Protocol” packets tell other routers
about the subnet that has been created so that they know to send packets
for nodes on that subnet to TribeStar. Do not check this box if you will
manually configure other routers with the subnet information using the UNIX
“route add” command.
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Figure 10. IP Config screen to �Forward� IP packets

IP Interface Parameters

7. Address:  Enter the TribeStar’s IP address on the Ethernet IP backbone.

8. Mask: Enter the mask of the IP network to which you are connected. If you
are not sure if you have a subnet mask, consult your IP network administra-
tor. If you do not have a subnet mask, you may click the “default” button, and
the mask will be automatically calculated.

9. Broadcast:  Enter the broadcast address of the IP network to which you are
connected. If your network does not have a subnet mask, you may click the
“default” button and the mask will be automatically calculated.
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MacIP Parameters
10. Select “Forwarding”  for KIP-style forwarding or “Routing”  to create a

subnet for the MacIP client range.

If you select “Forward”:

11. Address:  The MacIP address is the same as the IP interface address. This
field cannot be changed.

12. Client Range: This is the range of IP addresses that TribeStar will handle.
Make sure that no IP addresses within the client range are in use by other
nodes on the network. TribeStar will intercept all IP packets addressed to
nodes within this range and forward them to LocalTalk. Addresses that fall
within the client range but outside the dynamic range (see below) can be
statically assigned through MacTCP on each Macintosh. TribeStar can
handle a range of up to 128 addresses as its clients.

13. Dynamic Range:  This is the range of addresses that TribeStar will hand out
to Macs that ask for an IP address. If this range is the same as the Client
Range, then TribeStar will be able to dynamically hand out all the addresses
within the Client Range. If Macs try to acquire more addresses than are
available, MacTCP will show an error indicating that it is unable to acquire an
address.
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Figure 11. Routing IP packets

If you select “Routing”:

1. Address: This is the IP address of the TribeStar on the MacIP subnet. For
more information on how to calculate subnet numbers, see the IP
Subnetting  section. Make sure that this address is the bottom number in a
subnet range that offers the desired number of host addresses.

2. Mask:  Calculate the mask for the IP subnet you are using. (For more
information on how to calculate subnet masks, see the IP Addressing
section.)

3. Broadcast Address:  Calculate the broadcast address for the MacIP subnet
and enter it here.

4. Dynamic Range:  If you select “Subnet”, there is no need to configure the
client range, because this is automatically equal to the number of host
addresses contained within the subnet. The Dynamic Range is still specified,
however, indicating which addresses TribeStar may dynamically assign.
Addresses that fall within the subnet host range but outside the dynamic
range can be statically assigned through MacTCP on each Macintosh.
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Optional MacIP Parameters
These parameters are rarely used and come into play only if a specific application
requires that they be configured. In those instances, follow the instructions for the
application.

Configuring MacIP with Multiple TribeStars

MacIP is limited to one gateway per AppleTalk zone.  If you have TribeStars in
different zones, you may be best off configuring each TribeStar with MacIP. This
minimizes the load on each TribeStar. (See PART IV: Configuration  for more
information on using TribeStar with multiple zones.) If you have one zone encom-
passing several TribeStars, you must designate only one TribeStar to be your
MacIP gateway. (See Figure 12.)

EN EN EN

IP Router
(Cisco, etc.)

TribeStar A TribeStar B
MacIP Gateway

TribeStar C

Zone: Accounting

Figure 12. MacIP with multiple TribeStars
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IP Configuration Scenarios

Configuration Scenario Using KIP 

Forwarding
The following scenario illustrates the configuration of TribeStar for an un-
subnetted Class C network using KIP-style forwarding. For more information on
how these parameters were calculated, consult the Introduction to TCP/IP
Protocols  and MacIP Fundamentals  chapters.

IP Routes:

Default Gateway: 205.100.150.5

Generate RIP: not checked. (Unnecessary with no subnet.)

IP Interfaces:

Address: 205.100.150.6

Mask: 255.255.255.0

Broadcast: 205.100.150.255

MacIP:

Select Forward

Address: 205.100.150.6 (same as IP Interface Address;
cannot be changed.)

Client Range: 205.100.150.7 to 205.100.150.67. (This allows for up
to 60 addresses.)

Dynamic Range: 205.100.150.27 to 205.100.150.67. (This allows the upper 40
addressed to be dynamically assigned by TribeStar. The bottom 20 ad-
dresses may be statically assigned to Macintoshes, if desired.)

Optional MacIP Parameters:

Do not use.

Configuration Scenario Using MacIP routing

The following scenario illustrates the configuration of TribeStar for a subnetted
Class C network using routing for MacIP. The Class C network is subnetted into
eight parts with the top three bits of the fourth byte—the top of the host address
portion of the IP address space.
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TribeStar‘s IP address is on the first subnet. The MacIP subnet is on the second
subnet. The MacIP subnet has space for up to 32 nodes. For more information on
how these parameters were calculated, consult the Introduction to TCP/IP
Protocols  and MacIP Fundamentals  chapters.

IP Routes:

Default Gateway: 135.200.73.10

Generate RIP: Checked. (Check unless you will manually
configure the default gateway with a new route

to the MacIP subnet.)

IP Interfaces:

Address: 197.200.73.11

Mask: 255.255.255.224

Broadcast: 135.200.73.31

MacIP:

Select Routing

Address: 197.200.73.32 (First address in the second
subnet.)

Subnet mask:  255.255.255.224

Dynamic Range: 197.200.73.43 to 197.200.73.63. (This allows the upper
21 addresses to bedynamically assigned. The
bottom 10 addresses may be statically assigned to
Macintoshes.)

Optional MacIP Parameters:

Do not use.
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PART VI: Troubleshooting

Planning for a Rainy Day
When you install your TribeStar, we recommend that you use SwitchMonitor to
print out a listing of network devices. If you do not see all the network devices,
you may need to begin troubleshooting immediately. If all devices are appropri-
ately displayed, make a map and keep it in a safe place. It will be a great help if
you decide to move devices or upgrade machines.

Resources

Our second recommendation for those who are new to troubleshooting networks
is that you buy and read any of the many excellent introductory books on network-
ing technology. A solid understanding of networking principles goes a long way
towards helping you diagnose problems quickly.

If you are new to Macintosh networking, the MacWorld Networking Handbook
(by Dave Koisur, Ph.D. and Nancy E.H. Jones) explains networking basics, how
to install and manage an AppleTalk network, and how to connect to other plat-
forms. Troubleshooting Macintosh Networks (by Kurt VanderSluis and Amir
Eissa) describes good troubleshooting methodology and offers many useful tips.
For those who want to understand the intricate details about how AppleTalk
works, Inside AppleTalk (by Gursharan S. Sidhu, Richard F. Andrews, Alan B.
Oppenheimer) is the definitive work.

You may order the MacWorld Networking Handbook directly from IDG Books at
800-762-2974.

Troubleshooting Macintosh Networks is available from The Network Group at
206-789-3111.

The Tao of Troubleshooting

There are a few principles that, if applied consistently, can greatly help locate the
source of problems:

1. Check the wiring and the connections.  Chances are, its either the wiring
or the connections. Checking each wire and connection may seem tedious
but you would be amazed how many seemingly complex and potentially
devastating problems can be tracked back to a single faulty wire or loose
connection. Checking the integrity of each line and each connection is the
single greatest way to avoid network problems. Use your SwitchMonitor’s
Statistics screen to look for ports where the number of errors divided by the
number of received packets exceeds the acceptable 1% mark.

2. Isolate the problem.  In other words disconnect devices or ports to see
when the problem occurs and when it doesn’t. Try a different patch cable. If
something doesn’t work correctly with TribeStar in the network, find out if it
will work without TribeStar in the network.
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3. Be patient and methodical.  Don’t jump to conclusions. Networks are
complex systems with many unseen and unanticipated interactions. Some
devices contain unusual quirks that prevent them from working with other
devices.
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Six Commonly Encountered Problems
Problem One:  Devices don’t show up in the Chooser.

Problem Two:  Printer(s) not seen in a Macintosh’s chooser.

Problem Three:  LocalTalk devices fade in and out of the Chooser.

Problem Four:  “Cannot connect to AppleTalk.”

Problem Five:  Ethernet devices disappear.

Problem Six:  LocalTalk users can’t find Ethernet devices.

LocalTalk Network Problems

Problem One: Devices don’t show up in the Chooser.

Some LocalTalk devices connected off the TribeStar cannot see other LocalTalk or
Ethernet network devices and other network devices cannot see these LocalTalk
nodes in their choosers.

Solutions:

The most common reason for this problem is faulty wiring.

1. Loose RJ-21 Connector:

One of the RJ-21 connections that attaches the 50-pin cable from the TribeStar
to the patch panel or the punch down block is loose. This connector may look
like it is completely seated on both ends but if it is even slightly tilted, you may
loose one or more of your LocalTalk ports. Press each 50-pin connector in
firmly and secure the RJ-21 cable so that someone entering the wiring closet or
wiring area cannot readily bump or snag the cables, causing the loss of
LocalTalk ports.

2. Wires punched down improperly during installation:

If you have just installed your TribeStar or recently rewired your punch down
block, the reason you may not be able to see the devices on a port in the
chooser could be that the lugs you punched your wires down to do not corre-
spond to the lugs of the TribeStar’s LocalTalk ports. See the punchdown block
illustration in the Installing TribeStar  chapter.

3. Faulty wiring connection:

The popular PhoneNET or TurboNet connectors or the wiring that connects
your network device to your TribeStar may be faulty. Swap out a suspect wire
or connector and replace it with one that has been tested. If the suspected
wiring is concealed in the wall, swap network devices to evaluate if it is the
device or wiring that is at fault. An ohm meter is an excellent tool to test the
continuity of your wiring.
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If these wires have been swapped out and the device is still not showing in your
SwitchMonitor’s Network screen under Device Connections, then investigate
whether your patch panel or punch down block is correctly installed and
functioning properly. A punch down block installed upside-down would only
show ports five through eight as connected. An ohm meter can be used to
check your patch panel. Call Zoom Technical Support at (617) 753-0700 for
information on how to perform this test.

4. Devices have a different zone/network ID:

If the unseen Macintoshes or printers were not powered off when they were
connected to the network, they may have a network number or zone name that
do not match that of the other nodes. They will not be visible to your network
until they have the same network number and zone names.

To resolve the network or zone identity conflict, power off those computers and
printers, and power them on again while they are connected to the TribeStar’s
network. They will now learn the identity of the network and should be readily
seen in SwitchMonitor and in the Choosers of other Macs on the network.

Inaccurate Zone or Network Information

Problem T wo: Printer(s) not seen in a Macintosh’s chooser.

Solutions:

1. Inaccurate zone or network information:

If the printer(s) was not powered off at the time of its installation into a new
network or if the network number or zone name was changed and the printer
was not powered off, then the printer would not be seen by other devices in that
zone.

2. Faulty wiring or termination problems:

See the discussion in Problem One  about testing the continuity of the wiring to
your printer. If the printer(s) shows in your Macintosh’s chooser and then fades
out of the chooser, check your printer’s termination and the length of the wire to
your printer. See the MacWorld Networking Handbook  for specification on
cabling lengths and termination for LocalTalk as well as Ethernet.

NOTE: Printers are especially sensitive to termination problems.

3. LaserWriter driver is malfunctioning:

In the case where only one or more Macintoshes that have recently been
connected to a new network cannot see a printer(s), check the version of that
Mac’s printer drivers. There is at least one version of printer drivers that has a
bug that necessitates the trashing and reinstallation of that LaserWriter driver
(Apple’s LaserWriter driver 8.0). Before that Macintosh can properly ask for the
printers in its new network number and zone, it must have a printer driver that
can learn its new network ID. (Apple’s LaserWriter driver 8.1.1 fixes this bug.)

Problem Three: LocalTalk devices fade in and out of the Chooser

Solutions:

Lack of proper termination or too long a wiring length are the most typical reasons
for fading devices.

1. Improper termination:
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LocalTalk uses 120 ohm terminating resistors. Wires must be terminated at
both ends or the signals will be reflected, resulting in noise on the wire.
TribeStar is internally terminated. For each of the two wires leading from a
LocalTalk patch panel or punchdown block, you need a terminating resistor at
the other end of the wire, usually on the last device off that wire. If there are
only two wires leading from your patch panel, you’ll only need two resistors for
those last two Macintoshes or printers. Never put more than four resistors on a
LocalTalk port. (This means that you cannot have more than four “home runs”
per port.)

2. Overextended wiring length:

For 24 gauge UTP (unshielded twisted pair) wire, a common standard for use
in LocalTalk networks, the maximum distance is 3000 ft. Because all wire is not
of equal quality, a signal may not always reach the expected 3000 ft. mark; be
conservative in estimating your maximum distance. A 22-gauge UTP wire is
thicker and allows longer runs. Check the networking guide of your choice for
details on LocalTalk and Ethernet cabling distances.

ThinNet or 10Base2 cabling has a minimum length (0.5 meters, or 19 inches)
as well as a maximum length. Chapter 9 of the MacWorld Networking
Handbook  ,“Installing an Ethernet LAN”, includes important information on
Ethernet cabling length and termination.

Problem Four: “Cannot connect to AppleTalk”

“Cannot connect to AppleTalk” message is received when a Macintosh boots up or
tries to connect to the network

Solutions:

1. Network limitations exceeded:

There are too many users on the AppleTalk network. There are 253 network
addresses available within a single AppleTalk network. The AppleTalk address
ID numbers 1-127 are reserved for user’s nodes and Macintoshes. Service
devices, like network hubs, printers, file servers, and routers are allocated the
numbers 128-253. In the newer version of AppleTalk, allowances have been
made to extend the user range. If you have a network of over 150 devices on a
series of either TribeStars or LocalSwitches and no routers, you may have
begun to push the AppleTalk limits.

2. Faulty wiring is giving inconsistent connection to the network:

A crimped or broken wire that only provides partial connectivity to a device may
result in receiving this “cannot connect” message.

Common Ethernet Connection Problems

Problem Five: Ethernet devices disappear.

All the Ethernet devices connected to the TribeStar via ThinNet (10Base2) wiring
disappeared from the LocalTalk users’ choosers.

Solution:

1. Loss of a terminator or of TribeStar connection:
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If a terminator is removed from either end of the ThinNet cabling that entire
Ethernet segment will cease to function. Also, check your Ethernet connection
to see if it has become loose or if the lights of the transceiver show power and
functionality. See problem six.

Problem Six: LocalTalk users can’t find Ethernet devices.

After installation, the Ethernet devices connected to the TribeStar cannot be seen in
the LocalTalk user’s choosers but the LocalTalk side is functioning without problems.

Solutions:

1. Conflicting network information:

If both the LocalTalk and Ethernet devices were not powered off before the two
networks were combined into one network (by the TribeStar), they will have two
separate network identities. Power off all devices and follow the start-up
sequence described in the Installing TribeStar  chapter. If there is a router or
half-router on LocalTalk or Ethernet, this device must be powered on before the
TribeStar.

Hidden routers:  An Ethernet device that you think is simply a server may, in fact,
have unseen router software (e.g., Novell file servers or some UNIX servers). Check
for such hidden routers when zones, printers, or servers disappear. Some LocalTalk
devices that are not full routers also send out Router Table Maintenance Protocol
(RTMP) packets and should be treated like a router at installation (e.g., Shiva
LanRover™ and NetModem™ V.32).

2. Loss of physical connection to TribeStar’s Ethernet port:

Check the wiring and physical connection to the TribeStar’s transceiver. Check
the power light and transmit signal on the transceiver.

3. No power to transceiver:

Check the physical connection to the TribeStar. If this is intact, listen for the fan
within the TribeStar. It is operated by the same power source as the Ethernet
transceiver connection. If the fan is not operating, call Zoom Technical Support.
If the fan is operating, swap out the transceiver for another one that has been
tested.

4. Ethernet card(s) are malfunctioning:

When there is only one Ethernet Macintosh in the network and it is not possible
to verify the Ethernet functionality from other devices, it may be that the
Ethernet card is malfunctioning. The Ethernet card may be dated and only need
a ROM upgrade. Even if you just purchased the card, the package may have
been on the reseller’s shelf for four to six months. That is enough time for you
to have missed an upgrade that could cure significant bugs.

If you have checked with the manufacturer and found that this card is not in
need of an upgrade, try to swap out the card or swap out the Ethernet
Macintosh. If the second card or new Mac works, you have isolated the prob-
lem.
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Problems Noted in Diagnostics Printouts
Error messages printed in the “Diagnostics” page of SwitchMonitor can often
give clues as to what may be ailing your network. Listed below are some of
the more common messages and their possible causes.

“Possible Duplicate node ID”

This message may be caused by moving a device from one TribeStar LocalTalk port
to another without restarting (such as a PowerBook being moved from one wall plug
to another). In this case, there will be one occurrence of the message as TribeStar
learns the new location of the device. No action need be taken.

If, however, the same two ports are repeatedly listed as having possible duplicates,
there may well be two devices with the same node ID. This may have been caused
by connecting one of the devices to the network after it has started-up. It may,
however, just indicate some wiring problem on one of these ports that is preventing a
node from verifying the uniqueness of its node ID at start-up. If two devices show up
with the same node ID on separate ports in SwitchMonitor’s Network page, there is a
duplication, which is resolved by simply turning one of them off and then on again.

Duplicate node ID’s on two ports that show significant errors in SwitchMonitor’s
Statistics page are most likely caused by wiring problems, either intermittent connec-
tions preventing a node from verifying the uniqueness of its node ID or a loop
causing TribeStar to think that node is actually on two ports.

“External Router Timed-out”

Routers sometimes fail to send their RTMP (Routing Table Maintenance Protocol)
packets every ten seconds as prescribed by protocol. This message indicates that
no RTMP has been received in over 20 seconds. This could be because of unusu-
ally heavy traffic (TribeStar’s port 1 is more susceptible to this), intermittent wiring, or
simply a flaky or failing router. If there is no complementary “External router discov-
ered” message, then a router has crashed or has been removed from the network.

NOTE: Some devices, such as Shiva’s NetModem, may be configured to only be a
router when being used for dial-in, thus its use will be accompanied by complemen-
tary “discovered” and “timed out” messages. This is a normal occurrence.

“Rogue Router/TribeStar Detected”

This message indicates the reception of an RTMP packet from a router (or other
TribeStar), implying a network number that conflicts with this TribeStar’s network
number. This may occur for several reasons, including starting up a router with a
conflicting net number after TribeStar is already up on the net. (TribeStar should be
started up after any routers to glean the appropriate network number.)

In any case, this message indicates that either TribeStar or some router on the net is
currently misconfigured.
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“LSAger”

Each line of LSAger represents a packet that cannot be delivered to a particular
LocalTalk port because the destination node is no longer reachable on that port.
These packets are then “aged out” and a diagnostics message is issued.

You may see these messages when a user turns off their Mac or detaches a
PowerBook from the network without logging off a server. Some server software
isn’t smart enough to realize the node is no longer there and attempts to send it
packets anyway.

The “D” in the diagnostics message indicates the destination node of the packet
and the “S” comes before the sender’s node. “Que” indicates the LocalTalk port
number (minus 1) that the destination node is not found on.
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Getting More Information
The following list is intended to help you to become more familiar with networking
technology, and to help you get started with TCP/IP and Internet access.

Kosiur, Dave and Jones, Nancy E.H. (1992). The MacWorld Networking Hand-
book. San Mateo, CA: IDG Books Worldwide, Inc. (800) 762-2974

VanderSluis, Kurt and Eissa, Amir. (1993). Troubleshooting Macintosh Networks.
New York, NY: M&T Books

Sidhu, Gursharan S., Andrews, Richard F., Oppenheimer, Alan B. (1990). Inside
AppleTalk. Cupertino, CA: Apple Computer, Inc. (408) 996-1010

Krol, Ed. (1993). The Whole Internet User’s Guide and Catalog. Sebastopol, CA:
O’Reily & Associates, Inc.

Kehoe, Brendan P. (1993). Zen and the art of the Internet: A beginner’s guide to
the Internet. (2nd ed.) Prentice Hall.

Dern, Daniel P. (1993) The Internet Guide for New Users. McGraw-Hill, Inc.

Malkin, Gary Scott, & Marine, April N. (1992). FYI on questions and answers:
Answers to commonly asked “new Internet user” questions.

Network Working Group, Request for Comments 1325. [Available through anony-
mous FTP from host ftp.nisc.sri.com, directory rfc, file name rfc1325.txt]

To get MacTCP, contact your dealer or order directly from the Apple Catalog at
800-795-1000. A single user copy (part number E1785) is available for $59. A 20-
user license extension (part number E1786) costs $69.
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